An essential component of Advanced Traveler Information Systems, in-vehicle route displays give drivers route options, alert them to incidents, and show their present location. In this report, researchers explore multimedia interfaces to present route information to travelers using map, text, and auditory-based representations, focusing on developing portable multimedia interfaces.

The report concludes that the graphical user interface (GUI) for display of route information is satisfactory for small road maps. The GUI also proved useful for visually checking map quality. The Tcl/Tk toolkit, in which the GUI was developed, is a reasonable tool to design an interface because it is portable to many platforms. Speech generation tools are not yet robust enough for use with large maps. Future work could include extending the GUI to provide a hierarchical display for large road maps, extending the amount of information conveyed to the user, and improving speech generation techniques.
Acknowledgments

We would like to thank Jeffrey Johnson and Jim Weiser for their contributions to the project at the University of Minnesota. We would also like to thank Ron Dahl, Jeff Southward, and Marthand Nookala at the MnDot project review team for their reviews. Further thanks are given to the Tcl/Tk family.
## Contents

1 Introduction ............................................. 1

2 Background ............................................. 3
   2.1 Related Work ........................................ 3
   2.2 Our Focus .......................................... 4

3 Design Issues .......................................... 5
   3.1 Graphical User Interface Builder .................... 5
   3.2 Speech Synthesis ................................... 6
   3.3 Integration with Routing Module .................... 7
   3.4 Preparation of a Realistic Road Map ............... 11
   3.5 Cartography and Color Schemes Selection ........ 12

4 Overview of the System ............................... 13
   4.1 Overview of the Options ............................ 15
   4.2 Overview of the User Manual ...................... 18

5 Evaluation, Lessons Learned, and Future Work ........ 21

A User Manual ........................................... 25
List of Figures

1. Pipe Communications from the Interface to the Routing Software .............................................. 8
2. Sample Menus for Graphical User Interface ....................................................................................... 13
3. File Menu Hierarchy .......................................................................................................................... 14
4. Options Menu Hierarchy .................................................................................................................... 16
5. An Incident and Its Effect on Shortest Time Path ............................................................................. 17
6. Comparison of a Shortest Time and a Shortest Distance Route ......................................................... 19
7. A Highlighted Road Segment and its Corresponding Attributes Box ............................................... 27
8. Editing Road Attributes for a Road Segment ...................................................................................... 28
9. Favorite Points in the Options Menu ................................................................................................ 30
10. List of Directions for the Highlighted Path ......................................................................................... 31

List of Tables

1. Representative Speech-Generation Software Packages ...................................................................... 7
2. Interface Between GUI and Routing Module ...................................................................................... 9
3. Example Sequence of Messages Between User Interface and Routing Software ............................. 10
4. Road Types with Speed and Display Color ......................................................................................... 11
5. User Interface Functionality .............................................................................................................. 20
Executive Summary

Advanced Traveler Information Systems (ATIS) assist travelers’ with planning, perception, analysis and decision making in order to improve the convenience and efficiency of travel. Route display is an essential component of ATIS, easing the driving task by enhancing travelers awareness of routing options, alerting them to incidents, and displaying their present location. We explore multimedia interfaces to present route information to travelers using map, text, auditory-based representations. We focus on developing portable multimedia interfaces. We conclude that the graphical user interface (GUI) for display of route information is satisfactory for small roadmaps. The GUI also proved useful for visually checking map quality. The Tcl/Tk toolkit, in which the GUI was developed, is a reasonable tool to design an interface in since it is portable to many platforms. Speech generation tools are not yet robust enough for use with large maps. Future work could include extending the GUI to provide a hierarchical display for large roadmaps, extending the amount of information conveyed to the user, and improving speech generation techniques.
1 Introduction

Modern highway systems (highway signs, traffic sensors, and control systems) and car manufacturers are using an increasing number of computer systems in order to improve the safety and efficiency of transportation. On highways, traffic signals and electronic signs are being automated. Besides these systems, modern drivers get much of their vital traffic information from digital radios, and cellular car phones. Drivers depend on these sources of information for avoiding traffic bottlenecks and driving safely. These new technologies provide the driver with a copious amount of useful traffic information. However, drivers are able to absorb only a small amount of information while driving and may not be able to discern which information is critical to them. There is a need for research in designing interfaces to present the information to a driver using only a small cognitive bandwidth.

ATIS is one facet of Intelligent Transportation Systems (ITS) which is currently being developed to improve the safety and efficiency of automobile travel. An effective navigation system with static route selection, coupled with real-time traffic information, is a central part of ATIS. Route-planning services need to provide the following three facilities: (a) route computation, which may be based on criteria such as shortest travel distance or least travel time, (b) route evaluation, to find the status (e.g. travel time, incidents) of a given route between two points, (c) route display, to effectively communicate routing information to the traveler for navigation.

Routing information must be presented to the traveler in a meaningful but concise format. Three formats for route presentation exist, each of which has a separate level of detail and requires a different level of concentration. Routes can first be presented to the traveler through a highlighted path on a map that distinguishes the route from the rest of the road. Routes may also be presented as a list of directions that provide a greater level of detail for travelers who are unfamiliar with the road network. The list of directions presents the routing information in an auditory form using automatic speech generation.

We believe that an alternative presentation system, combined with human-factors based information selection models, will lead to a better interface for the driver in two ways: (a) the cognitive overloading of the driver will be reduced to allow him/her to concentrate on driving (b) the driver will be able to request useful information on demand and thus control the driving tasks better. In addition, the results of this research will be useful to transportation system designers in designing an effective system to communicate relevant information to the drivers.

This project explores the use of multimedia technology to design effective information display interfaces. We explore the use of a portable multimedia interface for in-vehicle routing using graphical, auditory, and text-based interfaces to convey route choices and warning information. We also explore the use of multimedia computer technology to customize information based on the drivers' location.
2 Background

Traditional interfaces such as dashboard-oriented display methods (e.g. dials, diodes) are severely limited for presenting information to the drivers. The recent introduction of computer screens to display large amounts of information has several limitations: mainly, when interacting with the system, the driver has to take his/her eyes off the road while reading the screen. This raises safety concerns in the use of computer screens during driving. Highway signs provide only local traffic information and do not assist in route planning. Radio bulletins convey very general information about only a few major highways during commuting hours. Furthermore, it is not clear how the traditional interfaces will convey large volumes of traffic information within the narrow bandwidth of attention that drivers can spare while driving.

2.1 Related Work

Current work in information presentation in smart cars has focused on developing multimedia systems that incorporate an on-board navigation function and display hardware. The display hardware includes fluorescent and liquid-crystal display systems [1, 2, 3, 4]. The Travtek project looks at the effect of alternative navigation guidance displays on safety-related aspects of driver behavior, and at the effect of alternative display configurations on driver performance and navigation [5, 6, 7]. Studies have been done on traffic control with variable message signs and also on the design and validation of headup displays for navigation [8, 9]. CRT displays are one of the most common choices for displays in smart cars today [10, 11]. A prototype product called Smartroute Systems uses synchronous audiotext and intelligent video graphics to efficiently disseminate the static and real-time traffic information to a wide variety of business clients and radio stations [12]. Other modes of access to traffic information by businesses have also been studied, including cellular phones, corporate voice mail, e-mail, cable television, direct fax, and modem links.

Several reasonable options for a traffic information system driver interface have been prototyped [13]. For the designs where simple text displays show incidents and congestion, there are three ways to select the highway of interest; a bidirectional scrolling menu, a graphic of the highways, and a phone-style keypad. Other routing conveyance methodologies have been explored. A voice-guidance routing methodology was developed as part of the Toyota Voice Router Guidance System [14]. The system had three key elements. Timely voice guidance alerted drivers' to upcoming turns through interactive voice generation methodology. This guidance is linked to suitable landmarks in the drivers view. Text-based queries and a display have also been studied in [15]. Divided cognitive attention while viewing displays is being studied in [16]. Some studies have been conducted to test the effect of letter size
in a message that is displayed to a driver [17]. As part of the Pathfinder project, road plots as accurate as paper maps are stored on optical disks. In this project, the driver chose a viewing scale that will showed all the major streets and freeways in the greater Los Angeles area, or a larger scale that showed only nearby side streets and alleys [18].

2.2 Our Focus

To overcome the inherent limitations of traditional approaches, we explore computer-based interfaces and evaluate alternative interfaces based on graphical, auditory, and textual methods. New ways of information presentation include synthesized voice, computer-screen displays, voice icons and command menus. We explore the use of a portable navigation system to support information selection and presentation to drivers after they have received vehicle and traffic information from various sources. The computer has methods to customize the information according to drivers' needs without overloading the driver. The information selection rules determine the criticality of each information piece, depending on the driving situation and also determine a mode of presentation for the information from the available alternatives.
3 Design Issues

The key issues in designing a portable multimedia interface for displaying routing information include the choice of a graphical-user interface builder, the choice of a speech generator, integration with the routing module, and the preparation of a realistic road map. We describe those issues in this section.

3.1 Graphical User Interface Builder

Geographical Information Systems (GIS) are used to support decision-making in many domains, including urban planning, facility management, and utilities. For example, the Environmental Systems Research Institute's ARC/Info has been used to increase the efficiency of delinquent tax collection in Kansas City, Kansas, to predict and manage the growth of communities around the country, to monitor rising sea levels, and to track the destination of African elephants by ivory hunters. GIS are attractive because they can be applied to a wide variety of problems, handling large volumes of geographic data and analysis through visualization.

While commercial GIS provide excellent cartographic facilities, they presented a number of difficulties for our project. First, they did not support an open platform (e.g. C++, X/motif), thus making it difficult to integrate the routing module and public-domain speech generator. Second, their support for networks (e.g. roadmaps) was inadequate in terms of supporting attributes such as road names, road types, and incidents. Thus, even if we were using the commercial GIS, we would have had to develop a large amount of graphics functions. Finally, most commercial GIS on Unix platforms were quite expensive (more than $10,000) and exceeded our budget.

In this project, we develop a graphical user interface for Advanced Traveler Information Systems in an open systems environment, using the Tcl/Tk toolkit, XWindows and Unix. The software is able to run on Unix workstations and Microsoft Windows NT. We also have an extensible interface to add new functions which are not supported by commercial GIS.

We first evaluated the graphical user interface builder Interviews as a candidate development platform. After three months of effort, it became clear that Interviews was neither robust nor capable of supporting large road maps. Consequently, we decided to use the newly emerging Tcl/Tk family of user interface development tools instead. Tcl/Tk commands provide a high level interface to graphical user interface (GUI) programming that hides the details of coding. The Tcl/Tk toolkit is available in the public domain and is used extensively. Tcl/Tk runs on many popular operating systems (e.g. Unix, Microsoft Windows), on personal computers, and on workstations.
Research tasks and activities needed for this project include getting familiar with the Tcl and the Tk toolkit through a literature survey and by writing simple programs. We then designed the interface using the Tcl/Tk. Alternative menu structures were analyzed. We could then plan the modularization and architecture of the software system. The system was then implemented and coded with the use of a high level interface provided by the Tcl and Tk commands. Different functions were implemented and tested. Feedback-based enhancements were evaluated and actualized.

3.2 Speech Synthesis

Speech synthesis is the enterprise of transforming text input into spoken output. There are several algorithms which perform speech synthesis. The easiest transformation involves recording the voice of a person speaking the necessary phrases. This is useful only when the variety of messages is limited. However, the quality of the speech is high, since it is a recorded human voice. More intelligent algorithms split words into small units called phonemes, of which the English language has about 40. One problem with using phonemes is that their combination requires fluid transitions between each pair of phonemes. The speech produced with phonemes is often of poor quality, but the memory required to store the phoneme is small. Breaking the phonemes into smaller units called diphones increases the quality of speech. Each diphone consists of a pair of phonemes split in the middle, which keep the transitions intact. The storage space for the diphone method increases to 1600 elements. Hence, the longer the units become (when more transition information is encoded), the higher the quality of sound produced and the greater the storage space required. Words can also be broken into syllables, half-syllables, words, or combinations of above [20].

We evaluated several software packages that synthesize speech. The criteria we used to judge the software was: the software must be in the public domain; the software must be not be interactive (should accept a string as input, produce speech from that string, and terminate); the software must be portable between machines running UNIX; the software must synthesize acceptable speech; and the software must be extendable.

The only package to meet the requirements was the SPEAK synthesizer. However, SPEAK has several deficiencies. Its capability to produce intelligent speech from street numbers is limited. It interprets the string “Turn left at 34th street” as “Turn left at thirty-fourth street” instead of “Turn left at thirty-fourth street”. One solution would be to store the street names as “thirty-fourth” instead of “34th”; however, this approach loses semantic information and increases storage requirements. Producing the synthesized speech requires considerable resources and user time. A typical spoken direction list consisting of:

*Starting at Penn Avenue.*

*From there turn left onto Highway 81.*
Table 1: Representative Speech-Generation Software Packages

<table>
<thead>
<tr>
<th>Package</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>klatt-0.02</td>
<td>Phoneme to waveform speech synthesizer</td>
<td>svr-ftp.eng.cam.ac.uk:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>comp.speech/sources/klatt-0.02.tar.Z</td>
</tr>
<tr>
<td>SPEAK</td>
<td>Text to speech program based on concatenation of pre-recorded speech segments. A function library can be used to integrate speech output into other code.</td>
<td>wilma.cs.brown.edu:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>/pub/speak.tar.Z</td>
</tr>
<tr>
<td>rsynth</td>
<td>Text-to-speech converter produced by combination of various public-domain pieces.</td>
<td>svr-ftp.eng.cam.ac.uk:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>/comp.speech/sources/rsynth-1.0.tar.Z</td>
</tr>
</tbody>
</table>

Table 1: Representative Speech-Generation Software Packages

From there turn left onto Broadway Avenue.
From there turn right onto Emerson Avenue.
From there turn left onto Plymouth Avenue.
From there turn right onto 9th Street.
From there turn right onto Park Avenue.
From there turn left onto Franklin Avenue.
From there turn right onto Park Avenue.
Take that road to your destination.
takes 13 seconds to transform into synthesized speech on a SUN 4 running SunOS 4.2 with 58 MB of memory.

3.3 Integration with Routing Module

Route display service includes a route optimization module which computes paths between given (source,destination) pairs, according to criteria such as the shortest distance or the least travel time. The graphical user interface needs to interact with the routing module to exchange (source,destination) pairs and computed routes as shown in Figure 1.

The user interface runs on top of the main memory routing software described in [19]. Thus, the user interface and the routing software must communicate information to each other since each runs as a separate process. There are two ways of achieving inter-process communication. Shared memory requires the communicating processes to share variables.
Information is exchanged through these shared variables. The processes must coordinate with each other to designate a section of memory as shared memory. Coordinating the setup of shared memory is difficult, but message passing is easy, since the processes explicitly share variables. Complementarily, the message-passing method allows the communicating processes to exchange messages. These messages are usually a stream of bytes which can be formatted either in binary or text form. Message-passing is easily implemented, but care must be taken to ensure that the messages are passed in the required format.

![Diagram](image)

Figure 1: Pipe Communications from the Interface to the Routing Software

The Tcl/Tk language only supports the message-passing method of communication. Tcl/Tk uses the notion of a *pipe* to handle communication between the user interface and an application program. These pipes support one-way communication, and the message type must be known in advance. Communication in this manner is analogous to the client/server method, where the user interface acts as the client and queries the routing software, which acts as the server.

Messages sent from the user interface to the routing software consist of a header and a body. The header specifies which command the routing software is to execute and specifies the format of the body. Table 2 shows the structure of the message-passing architecture employed by the routing software. Each message has a header and a body. The header identifies the request and is usually represented by a single character. The body carries arguments for the request. Some messages are one way (sound on/off), while others elicit return values (routing request).

An example pipe session is shown in Table 3.3. The map used in the example is a synthetic 4 by 4 node grid. The first two messages select the sound command, switching it off. The next two (3,4) select the map to be used. Message 5 requests route computation and messages 6 through 9 transfer the coordinates of the source and destination nodes. Messages 10 through 16 bring the resulting path, terminated by the "DONE", string back to the user interface. The next 5 messages return the text directions describing the resulting route. The last message quits the routing program.
<table>
<thead>
<tr>
<th>Description</th>
<th>Header</th>
<th>Body with Description</th>
<th>Return Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing</td>
<td>o</td>
<td>d (A* Distance)</td>
<td>none</td>
</tr>
<tr>
<td>Selection</td>
<td>t</td>
<td>t (A* Time)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>i</td>
<td>i (Dijkstra Distance)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>j</td>
<td>j (Dijkstra Time)</td>
<td>none</td>
</tr>
<tr>
<td>Edit Road Attributes</td>
<td>e</td>
<td>(Change a group of line segments' attributes)</td>
<td>none</td>
</tr>
<tr>
<td>Line Segment Attributes</td>
<td>a</td>
<td>r (modify attributes)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>m (modify only in current map)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a (modify in all maps)</td>
<td>none</td>
</tr>
<tr>
<td>Direction List Toggle</td>
<td>d</td>
<td>y (directions list on)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>n (direction list off)</td>
<td>none</td>
</tr>
<tr>
<td>Incident</td>
<td>i</td>
<td>a (add incident)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>r (remove incident)</td>
<td>none</td>
</tr>
<tr>
<td>Sound Toggle</td>
<td>s</td>
<td>y (sound on)</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td></td>
<td>n (sound off)</td>
<td>none</td>
</tr>
<tr>
<td>Read Map</td>
<td>r</td>
<td>(read a map)</td>
<td>none</td>
</tr>
<tr>
<td>Compute Route</td>
<td>f</td>
<td>start and destination points for route computation</td>
<td>list of edges in path, optionally followed by direction list</td>
</tr>
<tr>
<td>Quit</td>
<td>q</td>
<td>quit the user interface, terminate routing software</td>
<td>none</td>
</tr>
</tbody>
</table>

Table 2: Interface Between GUI and Routing Module
<table>
<thead>
<tr>
<th>#</th>
<th>GUI</th>
<th>Direction</th>
<th>Routing Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>s</td>
<td>→</td>
<td></td>
<td>designates sound command</td>
</tr>
<tr>
<td>2</td>
<td>n</td>
<td>→</td>
<td></td>
<td>turns sound off</td>
</tr>
<tr>
<td>3</td>
<td>r</td>
<td>→</td>
<td></td>
<td>designates read command</td>
</tr>
<tr>
<td>4</td>
<td>grid</td>
<td>→</td>
<td></td>
<td>specifies the map to read</td>
</tr>
<tr>
<td>5</td>
<td>f</td>
<td>→</td>
<td></td>
<td>designates find routing</td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>→</td>
<td></td>
<td>x coordinate of first point</td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>→</td>
<td></td>
<td>y coordinate of first point</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>→</td>
<td></td>
<td>x coordinate of second point</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>→</td>
<td></td>
<td>y coordinate of second point</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>←</td>
<td>3 3 2 3</td>
<td>line segment in path</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>←</td>
<td>2 3 2 2</td>
<td>line segment in path</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>←</td>
<td>2 2 1 2</td>
<td>line segment in path</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>←</td>
<td>1 2 1 1</td>
<td>line segment in path</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td>←</td>
<td>1 1 0 1</td>
<td>line segment in path</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>←</td>
<td>0 1 0 0</td>
<td>line segment in path</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td>←</td>
<td>DONE</td>
<td>terminating token for line segments in the path</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>←</td>
<td>Starting at Jarvis Street</td>
<td>Direction</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td>←</td>
<td>From there turn left onto Pederson Drive</td>
<td>Direction</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>←</td>
<td>From there turn right onto Jarvis Street</td>
<td>Direction</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>←</td>
<td>Take that road to your destination</td>
<td>Direction</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>←</td>
<td>DONE</td>
<td>terminating token for direction list</td>
</tr>
<tr>
<td>22</td>
<td>q</td>
<td>→</td>
<td></td>
<td>quit program</td>
</tr>
</tbody>
</table>

Table 3: Example Sequence of Messages Between User Interface and Routing Software
3.4 Preparation of a Realistic Road Map

We obtained road maps from two sources: TIGER files from the Census Bureau and the Minneapolis road map from MnDoT. TIGER (Topologically Integrated Geographic Encoding and Referencing) files are produced by the Census Bureau and contain information collected in the 1990 census. TIGER files store information for different counties in separate groups of files. The information for each county is further broken down into files containing separate attribute information. The underlying map geometry and topology stored in the files are interlocked as a series of logical tabulations and the links between them.

Each road segment in a TIGER file has three attributes: name, type, and CFCC. The road name is the name is taken from the TIGER file. The type of road is for nomenclature purposes and can have many values including street, road, highway, boulevard and drive. CFCC classifies a road according to the size of the road and its accessibility. A table showing speed limits is shown in Table 3.4.

Maps consist of a set of nodes and a set of edges. Edges connecting the points are displayed in different colors, depending on their types. For example, the Minneapolis road map data from MnDoT consists of 1089 nodes and 3300 edges that represent highway and freeway segments for a 20-square-mile section of the Minneapolis area. The data about each segment includes the x and y position of the two nodes, the average speed for the segment, the average occupancy, and the road type. For the Minneapolis road map, the edges connecting the freeway segments were one-way, making the resulting graph directed, as opposed to undirected. The road segments were obtained by digital imaging of the area, followed by regional identification. The map is shown in figure 4. The more dense center region is the downtown Minneapolis region. In this region, the highways and freeways are not parallel to the x or y axis. The outlying areas do show a more gridlike pattern of roads, except where lakes interrupt in the lower left corner and where the Mississippi river flows north to southeast in the upper right quadrant of the map. The map of Hennepin County is shown in Figure 3.

<table>
<thead>
<tr>
<th>Type</th>
<th>Speed (MPH)</th>
<th>Display Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown Highway Type</td>
<td>45</td>
<td>Dark Salmon</td>
</tr>
<tr>
<td>Primary Highways with Limited Access</td>
<td>65</td>
<td>Sea Green</td>
</tr>
<tr>
<td>Primary Road without Limited Access</td>
<td>40</td>
<td>Blue</td>
</tr>
<tr>
<td>Secondary and Connecting Roads</td>
<td>25</td>
<td>Gray</td>
</tr>
<tr>
<td>Local, Neighborhood, and Rural Roads</td>
<td>15</td>
<td>Black</td>
</tr>
</tbody>
</table>

Table 4: Road Types with Speed and Display Color
3.5 Cartography and Color Schemes Selection

Color Schemes for Computed Paths: Paths are displayed in red, green, blue, or yellow. Each route will be displayed in a different color until there are four routes on the screen. At that point, all future routes are displayed in yellow. The route color is reset when routes are removed from the display.

Color scheme for road type: This set of colors is used for road types in maps. This set is mutually disjoint from the set used for computed paths. It is fixed and is chosen according to different types of roads which are classified depending of their speed limits (this is true for all the maps except that of Minneapolis). The categorization of speed limits is taken from standard TIGER file classifications. Refer to Table 3.4 for the colors corresponding to the different CFCC’s.

Color scheme for incidents: Incidents are marked by a black X. For an example of an incident, refer to Figure 5.

Color scheme for highlighted points: Highlighted points are marked by a black circle.

Color scheme for highlighted lines: Highlighted lines are displayed by a thick black line. For an example of a highlighted road segment, please refer to figure 7.
4 Overview of the System

The main memory route-finding software and GUI are developed on a SUN/4 with 24Mb of main memory running SunOS 4.1.3. The route computation software consists of 7000 lines of C++ code. The code was compiled with g++ version 2.4. The GUI is 1000 lines of Tcl/Tk code.

The graphical user interface (GUI) displays a map. Travelers can query the map for roadway information such as road name and average road speed. Travelers are able to set up favorite point aliases to frequented map locations such as their home and work place, thus enhancing usability. The GUI allows users to add incidents to the map. Incidents model roadway hazards such as bad weather, accidents, and congestion. Travelers are able to choose between the shortest distance routing and the shortest time routing. Figure 2 shows the menu structure for the graphical user interface.

![Figure 2: Sample Menus for Graphical User Interface](image)

There are three menu entries of the menubar: File, Display, and Options. Clicking the left mouse button on each entry will give a hierarchy of available options, as discussed below.

- **File**: Contains the list of displayable states and their maps. Placing the cursor on the **Open State** option lists the states for which maps exist. For each state, there will be a list of maps of counties or cities. A region or county can be selected with the mouse. Selecting the **Exit** option terminates the program.

  Figure 3 shows the File menu hierarchy. In this example, Hennepin County in Minnesota from the **Open State** menu has been selected. Therefore, the displayed map is the map of Hennepin County in Minnesota. For instructions on how to display the map of a selected region, refer to Appendix A.

- **Display**: Contains the options for displaying and manipulating maps, including highlighting points, highlighting lines and unhighlighting paths from a map. The **Highlight Lines** and **Highlight Points** options are in the form of menu buttons, and the
Figure 3: **File** Menu Hierarchy
Display and Unhighlight Path option is in form of a simple menu-bar entry. Each option can be selected with the mouse. The Highlight Lines option is used for finding and/or changing the attributes of a road segment, which includes its name, type and CFCC. The Highlight Points option is used for finding the shortest path in time or in distance between a source and a destination point. This option is also used for adding or removing incidents and for selecting favorite points, an alias for a commonly used location. The Display option is used to display the map of a selected county or region. The Unhighlight Path is used to unhighlight previously highlighted paths. Refer to Appendix A for further instructions on these features.

- **Options**: Contains all the services provided by this system. These options are: Favorite Point selection, Sound feature, editable Road Attributes, Incidents addition and removal, Direction listing, and Routing services. Figure 4 shows part of the Options menu hierarchy. You can see interstate highways in a dark green color and the downtown area in a dark blue color. Here the menu for the Routing option is opened. The following section explains the services provided by the Options menu hierarchy in more detail.

### 4.1 Overview of the Options

The following options constitute the services provided by the package:

- **Favorite points**: This is an alias for a commonly chosen map location. Favorite points speed up route selection by allowing the travelers to select points from a list of favorites rather than from the map.

- **Sound**: When its suboption On is chosen, it presents routing information to the traveler.

- **Road**: When Change Attributes is chosen, you can use it to change road information including the road name, type and CFCC.

- **Incident**: You can model accidents and other roadway hazards with this option. Figure 5 shows an example of an incident added to a selected road as, shown by the x.

- **Directions**: When Yes is chosen, it brings up a dialog box with the selected road’s directions on it.
Figure 4: Options Menu Hierarchy
Figure 5: An Incident and Its Effect on Shortest Time Path
- **Routing:** There are two methods of determining the optimal path available to the user: shortest linear distance and shortest trip time. Using the shortest linear distance heuristic will give the path with the least total distance traveled. The shortest trip time heuristic will produce the path from the start to the goal that takes the least amount of time to drive. Two edge costs were used for the above two heuristics: the distance between the nodes and the travel time between nodes. The travel time is taken from the historical travel time for that line segment. Figure 6 shows an example of a shortest time and a shortest distance route. The shortest distance path is highlighted in red. The shortest time path is highlighted in blue. Note that it travels along interstate 94 instead of going through downtown Minneapolis.

### 4.2 Overview of the User Manual

Appendix A gives more detailed instructions for the system. The following table gives an overview of all the services provided by this package.
Figure 6: Comparison of a Shortest Time and a Shortest Distance Route
<table>
<thead>
<tr>
<th>Action</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting a road map</td>
<td>Selects map of a county or a state. For example, in Figure 3, the map of Hennepin County has been selected.</td>
</tr>
<tr>
<td>Displaying a road map</td>
<td>Displays a map of a county or a state. For example, in Figure 3, the map of Hennepin County has been displayed.</td>
</tr>
<tr>
<td>Selecting a line from a road map</td>
<td>Selects a line segment from a map. The road selected will be highlighted and its attributes’ information appears in a dialogue box (if this option has not been disabled previously). For an example of this action, refer to Figure 7.</td>
</tr>
<tr>
<td>Selecting a point from a road map</td>
<td>Selects a point of intersection on a road map. This option is used for selecting a source and a destination point, or a favorite point. These are used in the optimal path or favorite point options.</td>
</tr>
<tr>
<td>Inclusion of road attributes</td>
<td>Changes road attributes for a selected road segment. An example of this option is shown in Figure 7.</td>
</tr>
<tr>
<td>Incident handling</td>
<td>Models road hazards such as accidents or bad weather. An example of this option is shown in Figure 5.</td>
</tr>
<tr>
<td>Sound effects</td>
<td>Presents the routing information to the user.</td>
</tr>
<tr>
<td>Favorite point selection</td>
<td>Sets up a favorite point alias to frequented map locations such as home or workplace.</td>
</tr>
<tr>
<td>Directions</td>
<td>Presents the direction information for a source-to-destination point route.</td>
</tr>
<tr>
<td>Optimal Path options</td>
<td>Presents routing information. This option has a hierarchy of menus which are used for finding the minimal distance or the minimal time route between a source and a destination point.</td>
</tr>
</tbody>
</table>

Table 5: User Interface Functionality
5 Evaluation, Lessons Learned, and Future Work

We have developed a multimedia interface for routing software which incorporates graphics, text and speech to display traffic information. Digital road maps are displayed in the graphical user interface with different road types shown in different colors. Users interact with the system through features such as route selection, road map queries, favorite points, and incidents. The user interface communicates with the routing module to produce optimal route information. This route is shown as a set of connected line segments and a list of directions. The routing module performs the speech generation.

The multimedia interface was reviewed at the January 1995 review meeting. The following recommendations were made on the first version of the user interface:

- The incident icon’s color should be changed from black to red
- Color is preferred in displaying the highways and freeways on the static road map
- The display of multiple computed paths with an option to erase all paths
- Multiple groups of favorite points should be allowed

We incorporated these changes, which were reviewed at the March 1995 quarterly review meeting. The user interface and routing software were shown at the CTS Conference and the National Conference on Undergraduate Research. Visitors from IBM, the Texas CTS, and ITS have used the program and seen a video tape highlighting the system.

Our experience with this project and the tools to build a multimedia interface is summarized below:

- **ATIS route display:**
  - GUI was useful for checking map quality
  - Color selection for road types and routes is critical
  - GUI display of routes is satisfactory for small road maps such as Minneapolis
  - Most users preferred text-based direction

- **Implementation medium:**
  - Interviews is not a satisfactory tool for displaying maps.
  - Tcl/Tk is a reasonable tool to build GIS to display maps and routes since it is portable to many platforms.
  - Larger names such as Mississippi taxed the speech-generation software. These words would probably need to be broken into parts or to be pre-recorded

21
We intend to resolve the following issues in future work:

- Generate a hierarchical display for large road maps
- Extend the route information presented to include travel distance and travel time
- Improve the speech generator
References


A User Manual

This traffic routing software provides you with services such as selecting a road map, displaying it, selecting lines(roads) or/and points on it, changing/editing road attributes, selecting favorite points from it, adding/removing incidents to it, finding the shortest path in time and in distance between two points, and also provides sound features.

Note: Selecting something means pressing mouse button 1 on it.

1. Selecting a Road Map:
   (a) Open the File menu.
   (b) Go to the Open State option.
   (c) Select one of the states.
   (d) Select a county.

2. Displaying a Road Map:
   (a) Select a road map (refer to 1).
   (b) Open the Display menu.
   (c) Select the Display option. (Note: Map display may take some time)

3. Selecting a Line from a Road Map:
   (a) Display a road map (refer to 2).
   (b) Open the Display menu.
   (c) Select the Highlight Lines option. When your cursor points to a line, that line will be highlighted on the map. If you select a line segment, a dialogue box will appear, giving you information about the name and type of the road selected. Figure 7 shows an example of a selected road segment along with its attributes dialog box. To get rid of the dialogue box, press the Cancel button. To unhighlight the highlighted line segments, select the Unhighlight Path option from the Display menu. Pressing Modify All modifies the road information across all maps. Pressing Modify Current will change the road information only in the current map.
4. Selecting a Point From a Road Map:

(a) Display a road map (refer to 2).
(b) Open the Display menu.
(c) Select the Highlight Points option. When the cursor is over a point, that point will be highlighted on the map in a large black circle. If you select two points (the first point will not stay highlighted on the map, but the second point will be), the shortest path between those points will be displayed. To get rid of the dialogue box, press the Cancel button. To unhighlight the highlighted line segments, select the Unhighlight Path option from the Display menu.

5. Changing Road Attributes:

(a) Display a road map (refer to 2)
(b) Select a line from the road map (refer to 3)
(c) Open the Options menu.
(d) Select the Road option.
(e) Select the Change Attributes. A window called Change Road Attributes will appear. Input the road name, type and CFCC. and press Modify. This action will modify the selected road’s name globally through the system. Press Cancel if you do not want to modify the road attributes. Figure 8 shows an example of changing a selected road’s attributes. The selected road is highlighted and the Change Road Attribute window is present.

6. Incident handling:

(a) Display a road map (refer to 2)
(b) Open the Options menu.
(c) Select the Incident option.
(d) Select the Highlight Points option from the Display menu
(e) If you select Add, a dialogue box called Add Incident will appear, asking you to click on the intersection where the incident occurred. A x will appear on your the selected intersection.
(f) Press the Cancel button on the dialogue box to cancel the incident.
Figure 7: A Highlighted Road Segment and its Corresponding Attributes Box
Figure 8: Editing Road Attributes for a Road Segment
(g) If you select **Remove** a dialogue box called **Remove Incident** will appear asking you to click on the intersection you want to remove an incident from. Select the intersection to remove the incident from. The \( \times \) corresponding to the incident will disappear. If you do not want to remove an incident press the **Cancel** button on the dialogue box.

7. Sound effects:

   (a) Display a road map (refer to 2).
   
   (b) Open the **Options** menu.
   
   (c) Select the **Sound** option.
   
   (d) If you select **On**, the routing information will be read to you when you select some routing option (refer to 10c).
   
   (e) If you select **Off**, there will be no sound until you select **On** again.

8. Favorite point selection:

   (a) Display a road map (refer to 2).
   
   (b) Open the **Options** menu.
   
   (c) Select the **Favorite points** option. A window called **Select File** will appear, asking you to select the file containing the favorite points. Double click on the desired file with the left button. Another window will appear, listing the favorite points for the corresponding map. To select a point, double-click on it with the left mouse button. Favorite points may also be added to the file by pressing the **Add** button. A window will appear prompting you to select a point on the map and to give that point an alias. To cancel press the **Cancel** button. Figure 9 shows an example of a favorite point menu. In this example, home and work locations have been aliased as favorite points.

9. Directions:

   (a) Display a road map (refer to 2).
   
   (b) Open the **Options** menu.
   
   (c) Select the **Directions** option.
   
   (d) If you select **Yes**, the list of directions will be displayed with the highlighted route. This option is **On** by default. Figure 10 shows an example of the dialogue box which appears to give the directions information for the selected road.
Figure 9: Favorite Points in the Options Menu
Figure 10: List of Directions for the Highlighted Path

- Starting at Nicollet Avenue
- From there turn left onto 25th Street
- From there turn right onto Lyndale Avenue
- From there turn left onto Lake Street
- Take that road to your destination
(e) If you select No, directions will not be displayed with the highlighted path.

10. Optimal Path options:

(a) Display a road map (refer to 2).

(b) Open the Options menu.

(c) Select the Routing option. For any of the routing options, you should first select Highlight Points from the Display menu. There are two methods of determining the optimal path between two points: the shortest linear distance and the shortest trip time. If Directions option has not been disabled, a window called Directions will appear giving you the directions from the source to the destination point (refer to 9). If Sound option has not been disabled you will also hear the directions (refer to 7). These methods correspond to the following options:

   i. **Minimal Distance**: The generated path will be the path with the least distance.

   ii. **Fastest Trip Time**: Gives the path with the shortest trip time between two points

   iii. **Dijkstra**: Uses the Dijkstra algorithm to compute paths.

   iv. **Dijkstra Trip Time**: Uses the A* algorithm to compute paths.